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MODEL PAPER - 2  
Duration : 2 ½ hours                                                            Marks : 80 

Note : 
(1) In Section I, Part A Question No. 1 is compulsory. 
(2) In Section I, attempt any two questions from Question Nos. 2 to 5. 
(3) In Section II, attempt any two questions from Question Nos. 6 to 9. 
(4) Answers to both Sections should be written in the same answer book. 
(5) Figures to the right indicate maximum marks. 
 

SECTION - I  (PART - A) 
 
Q1 (a) Answer the following briefly:   [3] 
 (i) What is a folder in Windows’95? 
 (ii) Explain the Undo and Redo options in Ms-Word. 
 (iii) What is TCP/IP? 
 
 (b) Answer the following in ‘C’: [1+1+1+2 = 5] 
 (i) What is the use of return statement? 
 (ii) What is a null statement? 
 (iii) What is the conditional operator? 
 (iv) What are the rules for forming variables? 
 
 (c) State whether the following statements are true or false: [3] 
 (i) In Windows’95 operating system a filename must not contain blank 
spaces. 
 (ii)  Windows’95 operating system allows you to open more than one 

application at a time. 
 (iii) In Ms-Word, Save As option allows you to save a file under some other 
filename. 

(iv) In Ms-Word, Go To option is available in the View menu. 
(v) In Ms-Word, a document can have either a header or a footer but not 

both. 
 (vi) While forming a table we can have a maximum of 25 columns. 
 
 (d) Answer the following in Foxpro: [3+2 = 5] 
 (i) Explain the use of following functions: 
  EOF() FOUND() CDOW()   
 (ii) Explain the use of following commands: 
  COUNT CLEAR ALL 

 
Q2 (a) What do the following ‘C’ programs print: [4] 
 (i) #include<stdio.h> 
  main() 
  { int a=789,b=1212; 
  float c=6767.8787,d=8787.9987; 
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  printf(“%-+6d %-8d\n”,a,b); 
  printf(“%+9.3f %-15.2f\n”,c,d); 
  return (0); } 
 

 
 (b) Explain briefly about the following:   [6] 
 (i) Printers (ii) Modem (iii) E-mail 
 
 (c) Write a program in ‘C’ to input for 25 persons the name and taxable 

income. Calculate and print the name and income tax using the following 
schedule: [6] 

   Income Income Tax 
   First 50000  nil 
  Next 10000  10% 
  Next 90000  20% 
  Excess  30% + 2% surcharge        
  Also, print the total income tax of all the persons. 
 
Q3 (a) Mention briefly the difference between the following:  [8] 
 (i) Impact Printers and Non-impact Printers (ii) LAN and WAN 
 (iii) Floppy disk and Hard disk   (iv) Usenet and Telnet 
 
 (b) What do the following ‘C’ programs print: [4] 
 (i) #include<stdio.h> 
  main() 
  { int x = 5, t = 0; 
   for(; x < 20; x += 4); 
   t+ = x*x; 
   printf(“%d\n”,t); } 
 
  

(c) A chemical company offers commission to their salesmen @5% of sales. 
In order to boost sales, company offers an additional commission(ac) 
@3% of amount exceeding Rs.10000/- whenever sales exceeds 
Rs.10000/-. Write a program in ‘C’ to input salesman name(sn) and 
sales(s) and then print his name, sales, commission(c) and additional 
commission(ac). [4] 

 
Q4.(a) State whether the following statements are true or false: [3] 
 (i) ROM is a volatile memory. 
 (ii) The storage capacity of floppy disk is more than CD-ROM. 
 (iii) Unix is a multi-user operating system. 

(iv) LAN system does not allow the user to share hardware, software and 
data. 

(v) Internet Explorer is an internet/web browser. 
(vi) Telnet is a service on the internet allowing to login from one computer to 

another as a distant terminal. 
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  (b) What is the full form of the following: [3]  
  HTTP  TCP/IP WWW  POP  FTP  BBS 
 
 (c) What do the following ‘C’ programs print: [4] 
 (i) main() 
  { int x=2, y=5, z=1; 
      while (z<10) 
      { x+=++y; 
        y+=x*z++; 
      if (y>100) break; 
      printf(“%d %d %d\n”,x,y,z); } } 
 
 (ii)    main()   
   { int a,b;   
   for(a=2,b=4;a<100;b+=4,a*=3)  
   {  a+=b ;   
       printf((“%-4d%4d\n”,a,b); } }  
 
 
 (d) Write programs in ‘C’. [6] 
 (i) Write a program to input two positive integers. Find and print their GCD 

along with the two integers. 
 (ii)  Write a program to find and print the sum of :  12 + 22 + 32 + … + 112   
  using do/while() loop.    20    21    22            210  
 
Q5 (a) Explain briefly about the following:   [6] 
 (i) Spike Suppressor  (ii) CD-ROM  (iii) Websites 
 
 (b) What do the following ‘C’ programs print: [4] 
 (i) #include<stdio.h> 
  main() 
  { int p,q,r; 
  for(p=1;p<5;++p) 
  for(q=3;q<6;++q) 
  { r=++p+q++; 
  printf(“%d %d %d\n”,p,q,r);} 
  } 
   

(c) Write a program in ‘C’ to input 10 pairs of values of x and y. Print 
co-relation co-efficient and regression equation of y on x  i.e. 

)xbyx(xyy −=−  [6] 
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SECTION - II 
 
Q6 (a) Answer the following in Windows’95: [4] 
 (i) Explain the procedure to rename a folder. 
 (ii) What is the use of Start button? 
 
 (b) Answer the following in Ms-Word: [4] 
 (i) What is the use of File Menu? Discuss any four options of this menu. 
 (ii) Currently you are editing a document, you want to enter "ALL THE BEST" 

in line no. 55 of the current page. This text should appear at the center of 
the line, in Arial font, in bold face with font size 14. Finally, save the 
document. Explain how to achieve this.  

 
 (c) There exist a Foxpro table called TEST.dbf containing fields roll number 

(RN, numeric,3), name(SNAME,character,20) and marks in 4 subjects 
(M1,M2,M3,M4,all numeric,3). Write a data entry program to add new 
records to this table. This program must allow the user to continue as long 
as he wants. Marks should be accepted between 0 and 100 only. [4] 

 
 (d) Write Foxpro commands for the following: [4] 
 (i) To change the number of decimal places to be displayed in computation 
to 3. 
 (ii) To draw a double line box from 5th row and 20th column to 15th row and 
60th column. 

(iii) To accept the value of a field called INCOME which should be in between 
0 and 50000 from row no. 10 and column no. 15 onwards. 

(iv) To convert a date stored in a variable DD into character type. 
(v) To display character day of week of 25/02/99. 
(vi) To display today’s date from 5th row and 10th column onwards. 
(vii) To round off the contents of a memory variable PROFIT to its nearest 

1000. 
(viii) To find the remainder after dividing A by B and store it in C. 

 
Q7 (a) Explain the procedure to delete a folder permanently in Windows’95. [2] 
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 (b) What is the use of Insert Menu in Ms-Word? Discuss any four options of 
this menu. [2] 
 
. (c) State whether the following statements are true or false in Ms-Word: [2] 
 (i) After opening Ms-Word, it always displays Document1. 
 (ii) The New option in File Menu allows you to open document in variety of 

forms such as General, Letters and Faxes. 
 (iii) Document saved without specifying the folder is always saved in My 

Documents. 
 (iv) Selection of font can also be done using Format Menu. 
 
 (d) Explain the difference between the following in Foxpro: [6] 
 (i) LOCATE and FIND/SEEK  (ii) EXIT and QUIT 
 (iii) REPLACE and STORE TO 
 
 (e) There is a Foxpro file called DEPOSIT.dbf containing fields Receipt no. 

(RN,N,5,0), Customer Name (CNAME,C,20), Amount Deposited 
(AMT,N,10,2), Rate of interest (RATE,N,5,2), Date of deposit 
(DEPDATE,D,8), No. of days deposited (NDAYS,N,4,0) and Address 
(ADDR,C,40). Write an interactive program requesting the user to enter 
receipt no. and then the program must search whether this receipt no. is 
found in  the file or not. If so, display customer name, maturity amount and 
maturity date on the screen otherwise display “Receipt not found”. The 
program must allow the user to continue as long as he desires. [4] 

 
Q8 (a) Answer the following in Windows’95: [4] 
 (i) What is the use of Taskbar? 
 (ii) Explain how to create a new folder. 
 
 (b) Answer the following in Ms-Word: [4] 
 (i) Explain the procedure to create a 4 X 3 table and then add two more rows 

to this table. 
 (ii) What is the use of Tools Menu? Discuss any four options of this menu. 
 
 (c) There is a file called BANK.dbf containing fields account no.(A_NO,N,6,0), 

customer name (CNAME,C,20) and balance (BALANCE,N,9,2). Write an 
interactive program in Foxpro requesting the user to enter account no. 
and then the program must search for it in the file. If found, the program 
must request the user to enter transaction amount and type of transaction 
(Deposit or Withdrawal) and then update the balance. Display the updated 
balance. If account no. is not found in the file display an appropriate error 
message. The program must allow user to continue as long as he wants.  [4] 

 
 (d) There is a file called "BALANCE" containing fields Customer Name 

(CNAME), City (CITY), amount of order (ORD_AMT), Advance Received 
(ADVR) where ORD_AMT and ADVR are numeric and others are 
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character. Write commands in Foxpro for the following:  [4] 
 (i) To display name and balance for every record without the record nos. 
 (ii) To list all the names in the alphabetical order along with advance received 

for those from PUNE city. 
 (iii)  To decrease amount of order by 5% and increase advance received by 

5% of order amount wherever order amount exceeds Rs.10000. 
 (iv) To find the total of advance received and store it in TA. 
 (v) To go to the first record where city contains "NAGAR" and balance equals 

to 0. 
 (vi) To find the number of records where balance amount is 0. 
 (vii) To sort the records according to city and in city according to name. 
 (viii) To index the records in the descending order of amount of order. 
 
Q9 (a) Answer the following in Windows’95: [4] 
 (i) What is the use of dialog box? 
 (ii) Explain how to copy a file called AMC.DOC from drive A to My Documents.
  
 
 (b) Explain the method to perform the following operations in Ms-Word: [4] 
 (i) To print a document quickly. 
 (ii) To open a file which is in C drive in the directory WORK. 
 (iii) To find the number of words in the text selected. 
 (iv) To insert a page break. 
 
 (c) Explain the use of following set commands in Foxpro: [4] 
 (i) SET PRINT ON/OFF  (ii) SET CONFIRM ON/OFF 
 (iii) SET EXACT ON/OFF  (iv) SET ESCAPE ON/OFF 
   
 (d) There is a table called MARKS.dbf. This table contains fields Seat No.   

(SN,N,4,0), Name(NAME,C,20) and marks in 4 subjects 
(M1,M2,M3,M4,all numeric,3,0). Write a program to print a report in the 
alphabetical order of names, showing seat no., name and marks in all 4 
subjects, total marks(TM), average(AVG)  and grade(GR). If marks are 
less than 50 in at least one subject then grade is “B” otherwise grade is “A’.
 [4] 

 
 



Provided By TyBcom.com 
 

 7 of 20 

MODEL PAPER - 2 SOLUTION 
Duration : 2 ½ hours                                                             Marks : 80 

SECTION - I  (PART - A) 
 
1a (i) A folder is also called as a sub-directory. It is a place where files or other 

folders are kept. Folders are assigned names and the rules are same that 
apply to filenames. 

 (ii) The Undo option enables you to reverse your most recent action and 
return your document to it’s previous state. To do so, select Edit Menu - 
Select Undo OR select Undo icon on the Standard Toolbar. The Redo 
option enables you to repeat the last action. To do so, select Edit Menu - 
Select Redo OR select Redo icon on the Standard Toolbar. 

 (iii) TCP/IP (Transmission Control Protocol/Internet Protocol)  enables 
different types of computers in the network using different operating 
systems, to communicate with each other efficiently. All computers on 
internet are connected using the TCP/IP protocol. 

 
1b (i) The use of return statement is: 
 a. It transfers the control back to the calling function. 
 b. It returns a value, this value could be a constant, a variable or an 

expression. 
 c. When written inside main(), it terminates the program. 
 (ii) When a particular statement contains a semi-colon only, it is called a null 

statement. The compiler does nothing when it encounters a null 
statement.  

   E.g.if (c != 5)   
     ;      
    else 
    break; 
 (iii) The conditional operator (?) is used to check the condition and evaluate 

the   given expression.  e.g. x = (y>9) ? 10 : 15; 
  If the value of y is greater than 9 assign the value 10 to x  else 15 to x. 
 (iv) Variable refers to name given to the location within the memory where 

data values are stored. Rules for forming variables are: 
 a. The first character must be an alphabet or underscore. 
 b. It can be followed by alphabets A-Z, a-z, digits 0-9, underscore(_) or slash 

(/). 
 c. It must be maximum 32 characters. 
 d. It must not be a keyword. 
 e. It must be unique. Upper and lower case variables are not same. 
  
1c (i) FALSE (ii) TRUE  (iii) TRUE 
 (iv) FALSE (v) FALSE (vi) FALSE 
 
1d (i) EOF() : This function is used to determine whether the  end  of file  has  



Provided By TyBcom.com 
 

 8 of 20 

reached  or not. It gives .T.  if  the record pointer reaches the end of file 
otherwise .F. 

  FOUND() : This  function  gives .T.  if  the  previous  LOCATE, CONTINUE, 
FIND  or  SEEK command was  successful,  otherwise  it returns .F.  

  CDOW() : This function gives the name of the day of the week from the 
given date.  E.g. ? CDOW(DATE())  

(ii) COUNT : This command is used to count the number of records in a 
database file.     E.g. COUNT FOR AGE = 25 

  CLEAR ALL command will close all the files (database and index files) 
and clear off all the memory variables from the memory. 

 
2a  Output : (b denotes blank space) 
 (i) +789bbb1212bbbb (ii) 440 
  +6767.879b8788.00bbbbbbbb 
 
2b (i) Printers : A Printer is an output device which gives a permanent or 

hardcopy of the output, which can be used for future reference. Printers 
are classified depending upon their : mode of printing and speed of 
printing. 

 a. Depending upon the mode of printing printers are classified as : 
  Impact printers : In these printers there is a physical contact between the 

print mechanism and the paper. They are slow, noisy and cheaper than 
non-impact printers. We can obtain carbon/multiple copies. e.g. Daisy 
Wheel, Dot Matrix, Drum and Chain Printer. 

  Non-impact printers : In these printers there is no physical contact 
between the print mechanism and the paper. They are generally faster 
than impact printers and noiseless. They are very costly. We can obtain 
only one  copy at a time. e.g. Laser, Ink-Jet, Thermal Printer etc. 

 b. Depending upon the speed of printing printers are classified as: Character 
Printers are those which print one character at a time. e.g. Daisy Wheel 
and Dot Matrix Printer. 

  Line Printers are those which (apparently) print one entire line at a time. 
e.g. Drum and Chain Printer. 

  Page Printers are those which (apparently) print an entire page at a time.  
  e.g. Laser, Ink-Jet and Thermal Printer. 
 
 (ii) Modem : Modem is a peripheral device that links your computer to other 

computers using the telephone line. It basically does modulation and 
demodulation i.e. converts binary signals (digital) to voice signals (analog) 
and vice versa. It is also needed to connect a computer to the Internet.  

  Modems can be internal/external. The modems can transfer data at 
speeds ranging from 1,200 to 33,600 bits per second (bps). Usually a 
speed of 14,400 bps is considered satisfactory. The speed of 
communication depends on the speed of modems at both ends and the 
final speed will be of the slower modem. 
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 (iii) E-mail :  Electronic mail (E-mail) is the most widely used application of 
internet today. It enables users to send and receive messages over a 
network from one computer to another. It is a very convenient, economical 
and fast way of communication, using internet.  

   E-mail address is required to send or receive E-mail.  An E-mail address is 
made up of three parts: 

 a. The first part is the user name or user ID. 
 b. The second part is the name of the server or host computer on which the 

mails will be received. 
 c. The third part is the domain address. 

 So the E-mail address is written as User name@Server name.Domain 
name 
 E-mail addresses are used in software programs like Eudora, Outlook 

Express, etc. and not in browser programs. Some examples of E-mail 
addresses are :  amit@sys.net.in , rita@bom3.vsnl.net.in 

 Some other advantages of E-mail are : 
a. A message can be composed off-line by  using any editor and later can be 

included in the E-mail as an attatchment.   
b. It is also possible to send picture, sound and video files by attatching them 

to the message. 
c. A copy of the message can be sent to many persons. 

 
2c  #include<stdio.h> 
  #include<stdio.h> 
  main() 
  {  
  char name[10]; 
   float ti, it, tit = 0, i; 
   for (i=1; i<=25; i++) 
  { 
  printf("ENTER THE NAME AND TAXABLE INCOME "); 
  scanf("%s %f", name, &ti); 
  if (ti <= 50000) 
    it = 0; 
  else if (ti > 50000 && ti <= 60000) 
    it = (ti-50000)*0.10; 
  else if (ti > 60000 && ti <= 150000) 
    it = 1000 + (ti-60000)*0.20; 
  else 
    { 
    it = 19000 + (ti-150000)*0.30; 
    it = it + it*0.02; 
    } 
  tit = tit + it; 
  printf("NAME = %s\n", name); 
  printf("INCOME TAX = %.2f\n", it); 
  } 
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  printf("TOTAL INCOME TAX = %.2f\n", tit);  
  } 
 
3a (i) Impact printers : In these printers there is a physical contact between the 

print mechanism and the paper. They are slow, noisy and cheaper than 
non-impact printers. We can obtain carbon/multiple copies. e.g. Daisy 
Wheel, Dot Matrix, Drum and Chain Printer. 

  Non-impact printers : In these printers there is no physical contact 
between the print mechanism and the paper. They are generally faster 
than impact printers and noiseless. They are very costly. We can obtain 
only one copy at a time. e.g. Laser, Ink-Jet, Thermal Printer etc. 

 
 (ii) LAN : LAN means Local Area Network, where computers located at a 

short distance can exchange data and communicate. E.g. computers 
connected within an office or a building. 

  WAN : WAN means Wide Area Network, where computers which are far 
off from each other can exchange data and communicate using telephone 
lines and satellites. E.g. computers connected across different cities, 
states or countries. 

 
 (iii) Floppy disk : Compared to hard disk storage capacity of floppy disk is very 

less. e.g. 360KB, 1.2MB, 1.44MB. From the floppy disk access of data is 
slow. They are easily removable & transportable. They have a write 
protect notch. They are cheap. Read/Write heads within the drive touch 
the disk surface. 

  Hard disk : It’s storage capacity is very high. e.g. 40MB, 120MB, 260MB, 
600MB, 1GB, etc. From the hard disk access of data is very fast. They are 
not easily removable and transportable as they are fixed inside the CPU 
cabinet. They do not have a write protect notch. They are costly. 
Read/Write heads do not touch the disk surface. 

 
 (iv) Usenet : Usenet is a worldwide system of discussion groups also called as 

newsgroups. It is a network of other networks like BBS and computers 
which share and exchange news. Users can post messages on new 
subjects called articles, or reply to existing articles. 

  Telnet : Telnet is a service on the internet allowing the user to login from 
one computer to another on a remote system. This other computer may 
contain databases, library catalogs, information resources, etc. It requires 
the User-ID and password. Some computers permit guest logins. 

 
3b  Output : (b denotes blank space) 

(i) 441 (ii) 0b0b 
    c=28 
3c #include<stdio.h> 
 main() 
 {  
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 char sn[20]; 
 float s, c, ac; 
 printf("ENTER THE SALESMAN NAME AND SALES "); 
 scanf("%s %f", sn, &s); 
 c = s * 0.05; 
 if (s > 10000) 
   ac = (s-10000)*0.03; 
 else 
   ac = 0; 
 printf("NAME = %s\n", sn); 
 printf("SALES = %.2f\n", s); 
 printf("COMMISSION = %.2f\n", c); 
 printf("ADDITIONAL COMMISSION = %.2f\n", ac);  
 } 
 
4a (i) FALSE (ii) FALSE (iii) TRUE 
 (iv) FALSE (v) TRUE  (vi) TRUE 
 
4b (i) HTTP  - Hypertext Transfer Protocol 
 (ii) TCP/IP   - Transmission Control Protocol/Internet Protocol 
 (iii) WWW  - World Wide Web 
 (iv) POP   - Post Office Protocol 
 (v) FTP   - File Transfer Protocol 
 (vi) BBS   - Bulletin Board Service 
 
4c  Output : (b denotes blank space) 
 (i) 8b14b2 (ii) 6bbbbbb4 
  23b61b3  26bbbbb8 
    90bbbb12 
 
4d (i) #include<stdio.h> 

 main() 
 {  
 int a, b, ca, cb, r; 
  printf("ENTER THE TWO POSITIVE INTEGERS "); 
 scanf("%d %d", &a, &b); 
 ca = a; 
 cb = b; 
 r = a % b; 
 while (r != 0) 
 { 
 a = b; 
 b = r; 
 r = a % b;  
 } 
 printf("THE TWO INTEGERS ARE %d AND %d\n", ca, cb); 

   printf("THEIR GREATEST COMMON DIVISOR IS %d\n", b);  
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   } 
 
 (ii) #include<stdio.h>   #include<stdio.h> 
  #include<math.h>   #include<math.h> 
  main()     main() 
  {      { 
  float i=1, j=0, s=0;  float i=1, s=0; 
  do      do 
  {      { 
  s=s+pow(i,2)/pow(2,j);  s=s+pow(i,2)/pow(2,i-1); 
  i++;     i++; 
  j++;     } 
  }      while (i<=11); 
  while (i<=11);   printf(“SUM=%f\n”,s);  
  printf(“SUM=%f\n”,s);  } 
  } 
 
5a (i) Spike also known as spike-guard, is an electrical device containing an IC 

which is used as a stabilizer. It guards the computer system, whenever 
there is fluctuation in the power supply. The variation in the power supply 
may cause a major damage to any part of the computer so it is always 
advisable to connect the computer system to the spike and the spike to 
the main power supply. 

 
 (ii) CD-ROM stands for Compact Disc - Read Only Memory. The Compact 

Disc (CD) is developed using Laser Technology.  It is called as Compact 
Disc as it can store 650 MB of data. It is a circular platter 12cms in 
diameter. The surface of the disc has Lands and Pits. Lands are flat 
surface areas whereas Pits are tiny depressions on the surface of the disc. 
Lands reflect the laser beam whereas the Pits defuses it. These are 
understood as binary digits - 0’s and 1’s. One of the surface of the CD is 
coloured in silver, blue, green, gold etc, the data is stored on this surface. 
CD has become the best form of data storage as the data can be stored in 
huge quantity, it is long lasting, provides high speed and not so expensive. 
All new software’s are now-a-days available on CD’s. 

 
 (iii) Websites : A website is a place or location on the web giving detailed 

information about a specific topic. Government Organisations, 
Companies, News agencies, Television channels, Film producers and 
many other organisations or individuals have their own website. Some 
website addresses are www.vsnl.com, www.timesofindia.com,  etc. 

 
5b  Output : (b denotes blank space) 
 (i) 2b4b5 (ii) 124b102b134 
  3b6b8 
  5b4b8 
  6b6b11 
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5c  #include<stdio.h> 
   #include<math.h> 
   main() 
   { 
   float 

x,y,i,s1=0,s2=0,s3=0,s4=0,s5=0,m1,m2,n,d1,d2,r,byx; 
   for (i=1; i<=10; i++) 
   {  
   printf("ENTER THE VALUES OF X AND Y "); 
   scanf("%f %f", &x, &y); 
   s1 = s1 + x; 
   s2 = s2 + x*x; 
   s3 = s3 + y; 
   s4 = s4 + y*y; 
   s5 = s5 + x*y;  
   } 
   m1 = s1/10;   
   m2 = s3/10; 
   n  = s5 - s1*s3/10; 
   d1 = s2 - s1*s1/10; 
   d2 = s4 - s3*s3/10; 
   r = n/sqrt(d1*d2); 
   byx = n/d1; 
   printf("CO-RELATION CO-EFFICIENT = %f\n", r); 
   printf("REGRESSION EQUATION 

y-%.2f=%.2f(x-%.2f)\n",m2,byx,m1); 
   } 
 

SECTION - II 
 
6a (i) To rename a file/folder, follow these steps : 
 a. Select Start - Select Programs - Select Windows Explorer. 
 b. Go to the desired drive or folder. 
 c. Select the file/folder to be renamed.  
 d. Select File Menu - Select Rename. 
 e. Type the new name and press Enter. 
 
 (ii) Start button appears on the leftmost corner of the taskbar. It is used to 

start all programs and open various files. After clicking on the Start button, 
a menu with the following options, appears on the screen - Programs, 
Documents, Settings, Find, Help, Run and Shut Down.  

 
6b (i) File menu includes options related to file and print operations. This menu 

also displays the names of recently saved (worked) files. It is activated in 
following ways: 

 a.  Move the mouse pointer on the File menu and click the left mouse button. 
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OR 
 b.  Press Alt+ F keys. 
   Options from this menu are : 
 a.  New : It is used to create a new document. 
 b.  Open : It is used to open an existing document from the desired drive or 

folder. 
 c.  Close : it is used to close the document currently being edited. 
 d.  Save : It is used to save the document in the desired drive or folder. 
 e.  Print Preview : It is used to check the document on the screen, before 

printing. 
 f.  Exit : It is used to quit Word.  
  
 (ii)  To do so, follow these steps : 
 a.  Select Edit Menu. Select Go To.  
 b.  We will now get Find and Replace dialog box. 
 c. Select Line. Type 55 as line number. 
 d. Select Go To button to go to 55th line. Select Close button  to return back to the document.
 e. Type ALL THE BEST. Select ALL THE BEST with mouse or keyboard. 
 f.  To center the text - select Center icon from the Formatting toolbar.  
 g. To change the font, font size - select Format Menu - select Font. 
 h. We will now get Font dialog box. Select the font as Arial, font size as 14, font style as Bold
 i.  To save the document - select File Menu - select Save. 
 
6c  SET TALK OFF 
  USE TEST 
  ANS = "Y" 
  DO WHILE UPPER(ANS) = "Y" 
  CLEAR 
  APPEND BLANK 
  @ 5,20 SAY "ENTER THE ROLL NO." GET RN 
  @ 7,20 SAY "ENTER THE NAME" GET SNAME 
  @ 9,20 SAY "ENTER THE MARKS IN SUBJECT-1" GET M1 RANGE 0,100 
  @11,20 SAY "ENTER THE MARKS IN SUBJECT-2" GET M2 RANGE 0,100 
  @13,20 SAY "ENTER THE MARKS IN SUBJECT-3" GET M3 RANGE 0,100 
  @15,20 SAY "ENTER THE MARKS IN SUBJECT-4" GET M4 RANGE 0,100 
  READ 
  @17,20 SAY "DO YOU WANT TO CONTINUE ?" GET ANS 
  READ 
  ENDDO 
  CLOSE ALL 
  SET TALK ON 
  RETURN 
 
6d (i)  SET DECIMALS TO 3 

(ii) @ 4,19 TO 14,59 DOUBLE 
(iii) @10,15 SAY “ENTER THE INCOME” GET INCOME RANGE 0,50000 

  READ 
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 (iv) DD = DTOC(DD)    OR  STORE DTOC(DD) TO DD 
 (v) SET DATE BRITISH OR  ? CDOW({02/25/99}) 
  ? CDOW({25/02/99}) 

(vi) @ 4,9 SAY DATE() 
(vii) PROFIT=ROUND(PROFIT,-3)  OR  STORE ROUND(PROFIT,-3) TO 
PROFIT 
(viii) C = MOD(A,B)    OR  STORE MOD(A,B) TO C 

 
7a  To delete a file/folder, follow these steps : 
 a. Select Start - Select Programs - Select Windows Explorer. 
 b. Go to the desired drive or folder. 
 c. Select the file/folder to be deleted.  
 d. Select File Menu - Select Delete.  
 e. In response to the Confirm Delete message, Click on Yes. The file/folder 

is sent to the Recycle Bin. 
 f. Select File Menu - Select Close. 
 g. On the Desktop, double click on the Recyle Bin icon. 
 h. Select File Menu - Select Empty Recyle Bin. 
 i. In response to the confirmation, Click on Yes. 
 j. Select File Menu - Select Close. 
 
7b  Insert Menu contains options used to insert items like page numbers,  

page breaks, system date, time, symbols etc.  
  It is activated in following ways : 
 a. Move the mouse pointer on the Insert menu and click the left mouse 

button. OR 
 b. Press Alt+ I keys. 
  Options from this menu are : 
 a. Break : To insert a page break at the current cursor position. 
 b. Page Numbers : To insert page numbers in different ways. 
 c. Date and Time : To insert system date and time at the current cursor 

position. 
 d. File : To insert the contents of another file at the current cursor position. 
 e. Symbol : To insert a special character(symbol) at the current cursor 

position. 
 
7c (i) TRUE (ii) TRUE  (iii) TRUE  (iv) TRUE 
 
7d (i) LOCATE  : It helps us to search for the desired record.  It  does not need 

the index file.  
  FIND/SEEK  : It also helps us to search for the  desired  record, but  we 

need to index the file because this command searches  for the data in the 
index key field.  

 (ii) REPLACE : This command is used to change the contents of  fields, but 
not memory variables.  E.g. REPLACE CITY WITH “MUMBAI” 

  STORE  TO : This command is used to change the values  of  memory 



Provided By TyBcom.com 
 

 16 of 20 

variables, but not fields. E.g.STORE 25 TO AGE 
 (iii) EXIT : This command is used to terminate the loop and go to the 

statement after ENDDO. 
  QUIT : This command is used to terminate Foxpro and return back to the 

operating system. 
 
7e  SET TALK OFF 
  USE DEPOSIT 
  ANS = "Y" 
  DO WHILE UPPER(ANS) = "Y" 
  CLEAR 
  STORE 0 TO MRN 
  @ 5,20 SAY "ENTER THE RECEIPT NO." GET MRN 
  READ 
  LOCATE FOR RN = MRN 
  IF FOUND() 
   MA = AMT * (1+RATE/100)^(NDAYS/365) 
   MD = DEPDATE + NDAYS 
   @ 7,20 SAY "CUSTOMER NAME = "+CNAME 
   @ 9,20 SAY "MATURITY AMOUNT = "+STR(MA,10,2) 
   @11,20 SAY "MATURITY DATE = "+DTOC(MD) 
  ELSE 
   @ 7,20 SAY "RECEIPT NOT FOUND." 
  ENDIF 
  @13,20 SAY "DO YOU WANT TO CONTINUE ?" GET ANS 
  READ 
  ENDDO 
  CLOSE ALL 
  SET TALK ON 
  RETURN 
 
8a (i) The bar at the bottom of the screen is called the Taskbar. The Taskbar 

includes Start Button, a variable size button for each application, 
notification area giving information about date & time, incoming mails, 
faxes, printer status (active or inactive) etc. Taskbar can be resized or 
hidden while running an application. 

 
 (ii) To create a new folder, follow these steps : 
 a. Select Start - Select Programs - Select Windows Explorer. 
 b. Go to the desired drive or folder. 
 c. Select File Menu - Select New - Select Folder. 
 d. A new folder icon will be created and you will be asked to type a name for 

it. 
 e. Type a name and press Enter. 
 
8b (i) To create a 4 X 3 table, follow these steps : 
 a. Bring the cursor on a blank line in a document. 
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 b. Select Table Menu - Select Insert Table. 
 c. We will now get the Insert Table dialog box. 
 d. Type 4 in Number of Rows box and type 3 in Number of Columns box. 
 e. And, then select OK to return back to the document. 
 
  To add two more rows to the table, follow these steps : 
 a. Place the cursor in the last cell of last row. 
 b. Select Table Menu - select Insert Rows. 
 c. We will now get Insert Rows dialog box. 
 d. Type 2. Select OK. 
 
 (ii) Tools menu contains options used to check the spelling and grammar of 

the document, thesaurus, autocorrect, count the number of 
words/characters etc. It is activated by following ways : 

  Move the mouse pointer on the Tools menu and click the left mouse button
 OR Press Alt+ T keys. 

  Options from this menu are : 
 a. Spelling : It is used to check the document for spelling mistakes.  
 b. Grammar : It is used to check the document for grammatical mistakes. 
 c. Thesaurus : It provides a list of possible meanings and synonyms. 
 d. Word Count : It is used to count the number of words, characters etc. in 

the selected text or entire document. 
 e. AutoCorrect : It automatically corrects most of the common typing, 

spelling and grammatical errors.  
 
8c  SET TALK OFF 
  USE BANK 
  ANS = "Y" 
  DO WHILE UPPER(ANS) = "Y" 
  CLEAR 
  STORE 0 TO MA_NO 
  @ 5,20 SAY "ENTER THE ACCOUNT NO." GET MA_NO 
  READ 
  LOCATE FOR A_NO = MA_NO 
  IF FOUND() 
   STORE 0 TO AMT 
   STORE SPACE(1) TO TYPE 
   @ 7,20 SAY "ENTER THE TRANSACTION AMOUNT" GET AMT 
   @ 9,20 SAY "ENTER THE TYPE OF TRANSACTION" GET TYPE 
   READ 
   IF UPPER(TYPE) = "D" 
    REPLACE BALANCE WITH BALANCE + AMT 
   ELSE 
    REPLACE BALANCE WITH BALANCE - AMT 
   ENDIF 
   @11,20 SAY "UPDATED BALANCE = "+STR(BALANCE,9,2) 
  ELSE 
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   @ 7,20 SAY "ACCOUNT NO. NOT FOUND." 
  ENDIF 
  @13,20 SAY "DO YOU WANT TO CONTINUE ?" GET ANS 
  READ 
  ENDDO 
  CLOSE ALL 
  SET TALK ON 
  RETURN 
 
8d   USE BALANCE 
 (i) LIST OFF CNAME, ORD_AMT-ADVR 
 (ii) INDEX ON CNAME TAG CN 
   LIST CNAME, ADVR FOR CITY = “PUNE” 
 (iii) REPLACE ORD_AMT WITH ORD_AMT-ORD_AMT*0.05, ADVR WITH  
       ADVR+ORD_AMT*0.05 FOR ORD_AMT > 

10000 
 (iv) SUM ADVR TO TA 
 (v) LOCATE FOR “NAGAR” $ CITY AND ORD_AMT-ADVR = 0 
 (vi) COUNT FOR ORD_AMT-ADVR = 0 
 (vii) SORT ON CITY,CNAME TO CCN 
 (viii) INDEX ON ORD_AMT DESCENDING TAG OD 
 
9a (i) The dialog box in windows is used to : 
 a. Give more information to the user. 
 b. Receive more information from the user. 
 c. Receive confirmations from the user like Yes, No, OK, Cancel etc. 
 
 (ii) To do so, follow these steps : 
 a. Select Start - Select Programs - Select Windows Explorer. 
 b. From the Windows Explorer screen - Double click on the A drive. 
 c. Select the file AMC.DOC  
 d. Select Edit Menu - Select Copy. 
 e. Double click on the hard disk drive (C:). Double click on the folder My 

Documents. 
 f. Select Edit Menu - Select Paste. 
 
9b (i) To print a document quickly, Select Print icon on Standard Toolbar. 
 (ii) Select File Menu - Select Open. We will now get Open dialog box. Select 

the drive (C:) and directory (WORK).  Select the file to open. And, then 
select Open button.  

 (iii) To find the number of words in the text selected  - Select Tools Menu - 
Select Word Count. 

 (iv) To insert a page break, follow these steps: 
 a. Place the cursor at the desired position in a document. 
 b. Select Insert Menu - Select Break. We will get Break dialog box.  
 c. Select Page Break. And, then select OK. 
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9c (i) SET PRINT ON - This will cause the output of ?, ??, LIST, DISPLAY, etc 
commands to be sent to the screen as well as the printer.  

  SET PRINT OFF - This will cause the output of ?, ??, LIST, DISPLAY, etc 
commands to be sent only to the screen. 

 (ii) SET CONFIRM ON : This command is used, so that at the time of data 
entry when we fill up a field fully the cursor will not automatically move to 
the next field but will wait for us to press the Enter or Tab key. 

  SET CONFIRM OFF : At the time of data entry when we fill up a field fully 
the cursor will automatically move to the next field and not wait for us to 
press the Enter or Tab key. 

 (iii) SET EXACT ON - While comparing two character strings, FoxPro will 
check for exactly the same contents and length for both the strings. 

  SET EXACT OFF- Foxpro now checks for only those characters which are 
specified, starting  with the leftmost characters and ignores the extra 
characters. 

 (iv) SET ESCAPE ON  - Enables use of Esc key to interrupt program 
execution. 

  SET ESCAPE OFF - Disables the use of Esc key. 
 
9d  SET TALK OFF 
  SET DEVICE TO PRINTER 
  USE MARKS 
  INDEX ON NAME TAG NAME 
  @ 1,0  SAY "SEAT NO." 
  @ 1,10 SAY "STUDENTS NAME" 
  @ 1,35 SAY "SUB1" 
  @ 1,40 SAY "SUB2" 
  @ 1,45 SAY "SUB3" 
  @ 1,50 SAY "SUB4" 
  @ 1,55 SAY "TOTAL" 
  @ 1,61 SAY "AVERAGE" 
  @ 1,69 SAY "GRADE" 
  R = 2 
  DO WHILE NOT EOF() 
  TM = M1 + M2 + M3 + M4 
  AVG = TM / 4 
  IF M1 < 50 OR M2 < 50 OR M3 < 50 OR M4 < 50 
   GRADE = "B" 
  ELSE 
   GRADE = "A" 
  ENDIF 
  @ R,0  SAY SN 
  @ R,10 SAY NAME 
  @ R,35 SAY M1 
  @ R,40 SAY M2 
  @ R,45 SAY M3 
  @ R,50 SAY M4 
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  @ R,55 SAY STR(TM,3,0) 
  @ R,61 SAY STR(AVG,6,2) 
  @ R,69 SAY GRADE 
  R = R + 1 
  SKIP 
  ENDDO 
  CLOSE ALL 
  SET DEVICE TO SCREEN 
  SET TALK ON 
  RETURN  
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